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Map Basics: Visualizing




Working with Layers

» Start by opening a map or a geographic (dbd) layer
file
» Opening a layer will create a new map and add the layer
» Opening a map will load all saved layers, settings, etc.

«# Access layers with the layers dialog box ( = )

~
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Layers - !

Layers in Order of Display ~ Sample Status

Mode . Hidden - Close

H | Style. || Labels.. |[Autoscale.. || Rename.. | | Metadata |

Geographic File | Ch\.BR1653_setT_setting\networks\Inputs\16r16p_links.DED

| -~
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Working with Layers

- The Layers Dialog (= )

Layers - . =)
Layers in Order of Display  Sample Status / H |d e/S h ow a
Mode . Hidden = Close
— Ve
(o
' TERil  Add/Drop
layers
]

i Maowve Down \\
(e ) [ b | (Ao [ Fename. | [ Vitaaws | Re-order
ecgraphic FiIE|C:\.. Flbs3_set!_settinginetwor uts'16rl6p_links.DED Iayers

. N\

Change a Add/edit labels Automatically
layer style show/hide layers

as certain scales
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Working with Layers

= Layers are drawn from TOP to BOTTOM

Top layer ) y
(drawn first) = - i
Layers in Order of Display ~ Sample Status
Mode . Hidden - Close
p——
I Add Layer
Drop Layer

Mowe Up

Mowve Down

[

-

Style.. || Labels.. |[Autoscale.. | [ Rename.. | | Metadata |

Geographic File | Ch..BR1653_set]_setting'networks\Inputs\16rl6p_links.DBED

Bottom layer

(drawn last)
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Display Manager

» Activate from Map - Display Manager

=« Quick access to layers, settings, etc.

» Right-click for more settings, including make
working layer

Node layer is
Hide/show a active

layer

Q@ = — 16rl6p_links \

Add/edit labels

Bold text: links

layer is active

N

Change a
layer style
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Color Theme




Creating Maps

v ¥

Create a new map by opening a Geographic File (*.dbd)

Add more layers if desired
2 ﬁ then Add Laper

Choose the aCtlve Iayer File Edit Map Dataview Selection Teools Procedure

DEHE % n z) B &
» Use the dropdown selector % ®% %% M
| 8 Mapl - ~iz49

» QOr use the display manager

Change the “default” styles for the layers
» =% then Swe. | or %8 , or use the display manager

Hide or show layers
» =% or the display manager
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Color and Pattern Themes

» Set feature colors and styles based on
attributes

» Color Themes (|l ) are often used to display
facility type on a roadway network

» Pattern Themes (Map - Pattern Theme...) is
sometimes used to display number of lanes on a
roadway network
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Color and Pattern Themes
The Settings Tab

Options

Ignore values below

Std, Dew, per class

ke

[]Break at

[] Treat zeros as missing values

[ClInclude counts in legend

[Z] Reund off the values in each class

Caolor Theme (Layer 16r16p_links) | 8|
Settings |51},|5 |
Genera |
1
Field [Road Typel 1 [ Ssave.. |
Method  List of Yalues 2 Load..
Max Classes 512 |F‘ calculat |

l oK ] [ Cancel ] [ Apply ] [ Rermowe ] [Custnmize] )

10

1. Choose a field to
represent

2. Choose a method to
create categories and
number of classes

* Use the Load and Save
buttons to store and recall
settings

» This Is a huge time-saver!
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Color and Pattern Themes

The Styles Tab ~ 1. Choose a style for
Color Theme (Layer: 16r16p_links) SSL eaCh CIaSS

S

Choose a class

== 2. Select a legend text

Couny R ol e for each class
HOT Interstate

—— HOW Other
—— HOW - Interstate

N : 3. Choose from pre-
defined color settings
| o If desired

[-:-: Plevious] [ MNext == ] Swap Start and End

T W
N

&
)

| l OK ] [ Cancel ] [ Apply ] [ Remove ] [Customize] )
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Functional Class

Primary Facility Type Secondary Facility Type Primary Facility Type Secondary Facility Type
Freeways 10 Freeway R 70 Undivided
e 20 HOV 2 71 Divided
21 HOV 3+ 72 Continuous Left Turn
22 HOV - HOV Connector 73 Posted Speed 25
Expressway / Parkway 30 Undivided 74 Posted Speed 15
31 Divided, Interrupted s 80 Freeway to Freeway Connector
32 Divided, Uninterrupted 81 Freeway to arterial
Principal Arterial 20 Undivided 82 Arterial to freeway
41 Divided 83 Ramp Distributor
42 Continuous Left Turn 84 Ramp from Arterial to HOV
dllier Srie e 50 Undivided 85 Ramp from HOV to Arterial
51 Divided 86 Collector distributor
52 Continuous Left Turn 87 Shared HOV Ramps to MF
Major Col lector 60 Undivided 88 Truck only
61 Divided 9 Trucks 90 Truck only
62 Continuous Left Turn 100 100 Centroid Connector - Tier 1
Source: SCAG MOdel 200 200 Centroid Connector - Tier 2
Documentation, Appendix A “
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Functional Class

# Two Digit FT Codes

» Contained in AB_Facility Type and BA_Facility Type
» Difficult to use for map editing setup (too many details)

# One Digit FT Codes

» Not stored on the network TransCAD
Formulas.txt

» Can be computed /

if (AB_Facility_Type = 100 or BA_Facility_Type = 100) then 100 else
if (AB_Facility_Type = 200 or BA_Facility_Type = 200) then 200 else
if (AB_Facility_Type = 999 pr BA_Facility_Type = 999) then 999 else
if (AB_Facility_Type > 0) then s2i(left{string(aB_Facility_Type), 1))
else s2i{left(string(Ba_Facility_Type), 1))

Note: We will discuss formulas
in more detail in a later section
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Practice 1: Create a color theme for line layer using IFC field

1. Open the SCAG Network File (16R16pl_links.dbd)
v" File>Open, then in the file type dropdown next to ‘File name:” select Geographic File(*.cdf,.*dbd) option
v" Browse to the location/folder where the geographic file is located and select the ‘abmload.dbd’ and click
‘Open’ button p .
Formula (Dataview: 16rl6p_links) | 2 |
2. Add the MAP_FT Formula Field if (AB_Facility_Type =100 or BA Facility Type=100) then100 [ oK |
v' Dataview->Formula Fields else
view 8 ! . if (AB_Facility_Type = 200 or BA_Facility_Type = 200) then 200
v Open TransCAD Formuals.txt in notepad, then copy the MAP_FT formula else Delete
if (AB_Facility_Type = 999 or BA_Facility_Type = 999) then 999
v" Paste the formula and name the formula MAP_FT 'eée racliy-Type or BA.Fecility_Type = 9] then
v Click OK if (AB_Facility_Type > 0) then s2i{left(string(AB_Facility_Type),
1))
. . . . i , else s2ileft(string(BA_Facility_Type), 1)) MNode Fields...
2 On the top ribbon, click it is called ‘color theme map wizard _ _
Formula Builder Formula Fields Sum Fields...
4. It opens up a dialog box with two tabs. In the first tab ‘Settings’ tab: Field List... ~  MaPFT - Save...
v Selectthe MAP_FT from the ‘Field’ drop down options Operator List... +  Previous Formulas Load...
v Select the ‘List of Values’ from the ‘Method’ drop down options Function List. - -
v" Max. Classes: Use the default value (512) Values
5 Go to the ‘Styles’ tab Colar Theme (Layer: 16-16p_links) / [ — )
v" Observe the default styles Settings | Styles
v' QOptional: Set a preferred style for each facility type (we will use a shortcy|| cenew!
Field MAP_FT - Save..
6. Go back to the Settings tab, click the Load button. vithod [t Vo o o
4 Choose From Settings File Max Classes EEN ~
v" Browse to and select SCAG Training\Settings.stg
Options
v Choose MAP_FT and C“Ck OK Ig::lrevalues below “ |Drabuva “ |
v" Click OK again to complete the color theme dialog box Ste. Dew. per class
7. Save the settings (optional, method 1) Skip this step in training. ift
v" Tools > Geographic Utilties > Geographic file Round off the values in each class
. ) b [Tl Include counts in legen
v" Click Save Settings | e countenlegend |
1. Save the settings (optional, method 2) Use this method in training. ' ﬁ
14/ File —Save As \ [ ok AI Cancel | [ apply || RemaveIIC_-mmize]JBRlDGE SYSTEMATICS
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Extract and Interpolate Data




Customized Tool to Prepare Data

«» Caltrans D7 Air Quality Data Preparation Tool

Cavars 7 i iy e e

Data Extraction | Apply a Factor | Interpolation and Extrapolation |

Select Files or Folders
Project Link 1D File: | Browse |
5CAG Traffic Assignment Folder: | Browse |
Folderto Save AQ Results: | Browse |
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Flow Chart

Data Extraction
for the Air
Quality Analysis
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Prepare Input Files

(Project links and associated information)

Convert Excel
files to Bin files

Extract Traffic Assignment Results
(Using the GISDK script)

Copy CSV files to
Excel template files

Formatted AQ Data to be transferred to

the AQ Analysis Staff
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Input

-« The input file contains

19

» Project link number
» TransCAD link ID

» Topological direction
» Link length

» Route number

» Faclility type

» Post Mile etc.
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What Links should be included for
an AQ Analysis

# Project links

# Links connected to project links

» Usually include links that are within one intersection of the
project links

» Optional: Links on alternative routes

» A project might introduce more traffic on project links due to
higher capacities or free flow speeds, therefore leading to
more Vehicle Miles Traveled (VMT) and possibly more
emission.

» However, this project should have reduced traffic on
alternative routes, and then less emission on alternative
routes.

» In this situation, it is better to include links on alternative
routes in the AQ analysis. ﬁ
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What Links should be included for

an AQ Analysis
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Output

» CSV Flles

» Two or four freeway csv files, one for each direction
» One ramp csyv file
» One arterial csv file

# Copy to the Excel Template File

» Copy values only
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Exercise 2: Run the AQ Tool

# Install the AQ Tool (TransCAD Add-ins)
« Run the tool
» Examine the results
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Exercise 2-1: Install the AQ Tool

v

24

Step 1: In TransCAD, click Tools = Setup Add-Ins

Step 2: In the Setup Add-ins
window

»

»

»

»

»

»

Click the button “Add”
For Settings - Type, select “Dialog Box”

For Settings - Description, enter a
description of the tool

For Settings = Name, enter “Air Quality
Data Extraction” (must be exactly the
same, case sensitive, no quotation marks)

Click the “Browse” button to specify the Ul
Database, which is

“d7_airquality dataextraction.dbd” in the
folder of \D7_AQ_Tool”.

Click the “OK” button to close the window.

-_ ——_—_—_—_—_B—_B—_B—_B—_B—B—S—SS—
e L =
fadine Ok
- SR47 Postprocessor -
- Sample Code ]
- Everport Postprocessor — m
- SEMCOG Model -
- GENRTC Model
Hgg_Matnx = Mave
- APL PostProcessor
- Air Quality Data Bxtraction
- ChinaShipping Postprocessor
Mew Fold
- Caltrans D11 Post Processor Old Version -
Intefaces
Settings

Type: () Macro @ Dialog Box

Description [Air Quality Data Extraction

Name |Air Quality Data Extraction

Ul Database |n_v1'Tool\d7_airquality_dataestraction.dbd Browse. .

In Folder Mone -



Exercise 2-2: Run Data Extraction

» Step 3: Select the tool from Tools = Add-Ins

» Step 4: On the “Data Extraction” tab, specify the inputs and output
folder, and click “Run” to run the data extraction

» Project Link ID file is \SR-118 AQ_Input\Project_List SR-118 04062017.bin”

» SCAG Traffic Assignment Folder is
\SCAG_Model_Run\2016Build_Alt2_Phal\Assign_Output\”

» Folder to Save AQ Results is \AQ_Results\2016Build_Alt2_Phal\’
Caltrans D7 Air Quality Data PreparationTool =)

Data Bdraction |F¢>p|3ra Factaor | Interpalation and E:dmpalatiun|

Select Files or Folders

Project Link |D File: |C:"~.U...M_Input"».F‘mject_let_SHJ1E_ﬂ4062ﬂ1?.bin Browse

SCAG Traffic Assignment Folder: |C:"~L|...el_Hun\ZMDEuild_.ﬁ.l‘tE_F'hm‘\.Hssign_@utput\ Browse

Folderto Save AL Results: |C:"-.L|... Materal\ A2 _Results " 2040Build_AtZ Phal® Browse

YSTEMATICS i
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Exercise 2-3: Run Data Extraction

» Step 5: Repeat Step 4 for 2040Build_Alt2_Phal
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Exercise 2-4: Run Data Interpolation

» Step 6: Interpolate the results for 2025Build_Alt2 Phal based on
» 2016Build_Alt2_Phal
» 2040Build_Alt2_Phal

Data Exdraction | Apply & Fac:tm'l Interpolation and Exdrapolation |

Select Files and Folders

Year 1: 2016 Data Estraction File: |C:\U...ha1\F‘mject_IJst_5H—11B_D4062ﬂ1?_temp Browse

Year 2 (2040 Data Extraction File: |C:"~.U...ha1"~.F‘mjec:t_|Jst_SH—11B_MDEZG1?_temp Browse

SCAG Metwark Waorking File: |C:‘xL|...wnrks_OLrtertHlad\scag_ne-twnrk_wnrkjng Browse

Folderto Save AL Results: |C:"-.L|... Materal\ A2 _Results"2025Build_At? Pha Browse

Yearto Interpolate or Extrapolate: 2025 I Run ] I Qi l
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Exercise 3: Create the Final Output

» Copy the results to the template
@ Check the results
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Exercise 3: Create the Final Output

» Step 1: Make a copy of the template and rename it
» The template file is \SR-118 AQ _Input\SR-118 Air Quality Template v2.xIsx

» Step 2: Open the csv files* in Excel and copy values to the
corresponding spreadsheet in the Excel file from Step 1

» E.g. copy the content (without the first row) in “Project_List SR-
118 04062017 _Route118 East.csv” to the spreadsheet of “Freeways East” in the
Excel file from Step 1

» When copy from the CSV file, use the following tips to select the content faster

Click on Cell A2 (first column second row to leave out the title row), then use Ctrl + Shift + - (pressing
three keys together) on the keyboard to select all columns, then use Ctrl + Shift + | to select all rows from
Row 2.

» When paste to the Excel file, paste values only to preserve the format in the Excel
file. To do that, right click the cell where you want to paste in Excel and choose |7} in
the popup window.
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